226VA4L

www.philips.com/welcome

DK Brugervejledning 1
Kundeservice og garanti 27
Fejlfinding og FAQ 32

PHILIPS



Indholdsfortegnelse

1.

VIGLIGE cevrvvneencrercereneeceereeensensensenseesennees 1
1.1 Sikkerhedsforanstaltninger og
vedligeholdelse........ncinnsin. 1
1.2 Notationsbeskrivelser ... 3
1.3 Bortskaffelse af produkt og
emMballage ..., 4
Opsatning af skeerm........coceceevcuneneee 5
2.1 Installation )
2.2 Brug af skeerm ... 6
2.3 Fjern standeren og foden.....ccns 8
Billedoptimering 10
371 SMartContrast e 10
32 Philips SmartControl Lite ... 10
Tekniske specifikationer..................... 17
4.1 Oplgsning og forudindstillede
fUNKLONGN oo 19
StromMStYring ... 20
Lovmassige oplysninger-...........c....... 21
Kundeservice og garanti .................... 27
7.1 Philips' regler ved pixeldefekter pa
fladskaerme ...

7.2 Kundeservice og garanti

Fejlfinding og FAQ ....ccoveverevcrreeecnnee 32
8.1 Fejlfinding......
8.2 Generelle FAQ....oorerrvvviiisssssnnn 33




1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at lese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemerkninger angaende
brugen af din skaerm.

Philips garanti daekker under forudsztning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer, justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker:

Lees og felg disse vejledninger; nar du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen veek fra direkte
sollys, meget steaerkt og lyst lys samt fra alle
varmekilder. Laengere tids udszttelse for
sadan et miljg kan resultere i misfarvning
og skade pa skermen.

* Fjern alt, der kan risikere at falde i
ventilationsdbningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

»  Bloker ikke ventilationsabningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

*  Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du satter

stremkablet eller jeevnstrgmsledningen til
igen for at opna normal betjening.

* Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

e Udset ikke skaermen for kraftige
vibrationer eller stad under anvendelse.

»  Sla ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skarmen.
Nar du flytter din skeerm, sa tag fat
om rammen for at |gfte den. Laft ikke
skeermen ved at satte din hand eller fingre
pa LCD skaermen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en leengere periode.

» Tag stikket ud at kontakten til skeermen,
hvis du skal rengere den med en let fugtet
klud. Skeermen kan tgrres af med en tar
klud, nar der er slukket for stremmen.
Under alle omstandigheder, ma der ikke
bruges organiske opl@sningsmidler til
rengering af din skaerm.

» For at undga risiko for elektrisk sted eller
permanent beskadigelse af anleegget, ma du
ikke udseette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

e Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind i skermen, s sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skaermen til servicecenteret.

e Skaermen ma ikke bruges eller opbevares pa
steder, hvor den udseattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skaermen et sted, der



1.Vigtigt
er indenfor falgende temperatur- og
fugtighedsomrade.
e Temperatur: 0-40°C 32-95°F
»  Fugtighed: 20-80 % RH

Vigtige oplysninger om fastbrandte billeder/

spogelsesbilleder.

* Sorg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskarm eller et andet program,
der opdaterer skeermen regelmassigt,
hvis skaeermen viser statisk materiale
i lengere perioder. Uafbrudt visning
af et stilbillede over leengere tid, kan
fordrsage “brandmaerker”, ogsa kendt som
“efterbilleder” eller “spagelsesbilleder” pa
skaermen.

Tt

"“Breendmarker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfeelde vil “brandmarkerne’” eller
“efterbilledet” eller “spggelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Hvis der ikke aktiveres en pauseskaerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbrendinger” eller
“efterladte billeder” eller "spggelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade dakkes ikke af
garantien.

Service
* Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, s& kontakt
dit lokale servicecenter. (Se kapitel om
“"Kundeinformationscenter”)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

& Bemark

Kontakt en servicetekniker; hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal ggre, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.



1.Vigtigt

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner; der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

I hele denne vejledning kan tekstafsnit vaere
ledsaget af et ikon, og std med fed eller kursiv
skrift. Disse afsnit indeholder bemarkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler. De anvendes som falger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

(1) Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optrede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfeelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://mww.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2 Opsatning af sk&rm E1 Installation af stander

1. Anbring skaermen med forsiden vendt
nedad pd en bled og jeevn overflade, og vaer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1] Emballagens indhold 2. Fastger fodsgjlen pa skermen, sa den ldser

sig selv pa plads.

ngart

= Y PHILIPS

3. Hold pa skaermens stander med begge
hander, og st med en fast hand standeren
ind i fodsgjlen.

VGA‘ (\‘/algfri)v DVI (valgfri)



El Tilslutning til PC

I PHILIPS
)
(143

© AC stromindgang
© VGA-indgang

© DVI-D-indgang (tilgaengelig pa udvalgte

modeller)

O Lyd-indgang (tilgeengelig pa udvalgte

modeller)
© Kensington anti-tyverisikring

Tilslutning til pc

1. Tilslut ledningen ordentligt pa bagsiden af

skeermen.

2. Sluk for computeren og tag netledningen

ud af stikket.

3. Slut skeermens signalkabel til videostikket

bag pa computeren.

4. Saet computerens og skaermens
netledninger til et stik i nerheden.

5. Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen

gennemfert.

2.2 Brug af skeerm

El Produktbeskrivelse set forfra

p

PHILIPS 00000

Model 226V4LA:

AUTO/ W

(54
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Model 226VA4L:

(5]
AUTO/VY  [D/A /0/4\ @fOK dl)
(7] (6] o 6 O o
@ (O |Tenderog slukker for skeermen.
Sédan far du adgang til OSD-
menuen.
0 B/0K Bekreeft justering af
skeermmenuen.
Ga tilbage til det forrige OSD-
o < niveau.
O O |Justerer lysstryken.
© | AV [Tiljustering i skeermmenuen.
o 1 |Juster lydstyrken.
O |Skifter skeermformat.
@ | AUTO |Juster skeermen automatisk.




. Opsatning af skar

Bl Beskrivelse af OSD-visningen

Hvad er OSD (On-Screen Display)?

Visning pa skaermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skeerme. Den szetter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skeermens funktioner direkte via et
instruktionsvindue pa skeermen. Et brugervenligt
skaermvisningsinterface vises som nedenfor:

Model 226V4LA:

Grundleggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

VY A knapperne foran pa skeermen til at flytte
markgren med, og tryk pa OK knappen, til at
bekreefte dit valg eller eendring.

Main menu

— Input

OSD-menuen

Sub menu

L

VGA

DVI

(available for selective models)

Picture

Audio

:

Picture Format
Brightness —_—
Contrast -

SmartContrast —

Stand-Alone —

Mute —_—

(available for selective models)

Color

Language

OSD Settings

Setup

-

Color Temperature ——
sRGB

User Define

Nedenstaende er en generel oversigt over

strukturen i OSD-displayet. Du kan anvende
den som opslag, nar du senere skal orientere
dig i de forskellige justeringenr.

— Wide Screen, 4:3

0~100
0~100
On, Off

On, Off

On, Off

6500K, 9300K

Red: 0~100

Green: 0~100
Blue: 0~100

English . Espariol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, AL, Turkge

Horizontal —_—
Vertical —
Transparency -

OSD Time Out -

Auto

H. Position
V. Position
Phase
Clock

Resolution Notification
Reset

Information

0~100
0~100
Off, 1,2, 3,4

5Ss, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



El Meddelelse om oplesning

Denne skaerm er fremstillet til optimal ydelse
pa dens native oplasning, som er 1920 x 1080
@ 60 Hz. Nar skeermen bruger en anden
opl@sning, ses falgende advarsel pa skeermen:
Brug 1920 x 1080 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

a Fiernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




© Bemarkning

Denne skaerm accepterer et 100 x 1700 mm
VESA-kompliant monteringsinterface.




3. Billedoptimering

Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skeermel!

E Installation

3.1 SmartContrast .

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den @ger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en meark
baggrund.

E1 Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, laesbar tekst ved kontorarbejde.Ved at
nedseette skeermens stremforbrug, sparer du
energiomkostninger og forleenger skaermens
levetid.

El Hvordan virker det? .
Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og .
baggrundslysets intensitet indstilles. Denne

funktion forbedrer den dynamiske kontrast og .

giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hegrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, og er tilmed

10

Felg instruktionen og fuldfer installationen.
Du kan starte, ndr installationen er fuldfert.

Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS et phil comwelcorr

Opstartsguide

Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

Guiden leder dig trin for trin gennem
indstillingen af skeermen.

Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

| Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.



3. Billedoptimering

[ P 3+ Pien 22803 (E33013000001) )X [ P 3 - P 2333 (rs5aT3000001) (Tt

SmartControl Lite PHILIPS SmartControl Lite PHILIPS

Wizarnd Contrast

Contrast (st T skiee] 10 Kess decal »

2 ‘ ! -.
B — -
Aok o _ g
pos e

e Coverast »

i

a4

in
i
i

&g A &
&

o
E Start med Standard-vinduet: i SRR
Adjust menu (Indstillingsmenu): SmartControl Lite PHILIPS

*  Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),

Contrast (Kontrast), Focus (Fokus), Position ‘ g

(Position) og Resolution (Oplgsning).

* Udfer indstillingen ved at folge oy
instruktionerne. e
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3. Billedoptimering
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SmartControl Lite
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Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration

(farvekalibrering).
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PHILIPS
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» Udfer indstillingen ved at folge

instruktionerne.

*  Se nedenstaende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):
i er—

SmartControl Lite

.
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3. Billedoptimering

1.

“Show Me" (Vis Mig) starter vejledningen til Options > Preferences (Funktioner >
farvekalibrering. Indstillinger) - er kun aktiv, nar Preferences
Start — starter en 6-trins (Indstillinger) er valgt i Preferences (Funktioner)-

rullemenuen. Pa en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

B Smartcenol - Pl 1791 [C830713000001) (i

SmartControl Lite PHILIPS

farvekalibreringssekvens.

Quick View (Hurtigvisning) indleeser far/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er

e j@

i

=
=

i |

gratonede. ;
Der skal vaere patentoplysninger pé& ‘g s
kalibreringsskaermen. s =
" -
Forste farvekalibreringsskaerm: kg ST

* Viser nuveerende, foretrukne indstillinger:

e Funktionen aktiveres ved at afmeerke feltet.
Afmarkningsfeltet er en flip-flop.

* Enable Context Menu (Aktivér Indhold
menuen) er som standard afmeerket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite
pa Select Preset (Valg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen

Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskarm.

Next (Naeste) gar til efterfolgende mal ved at hgjreklikke p skrivebordet. Disabled
(seks mdl). (Deaktiveret) fierner SmartControl Lite fra
(Ga til sidst til File > Presets (File > Forvalg) genvejsmenuen.

vinduet «  Enable Task Tray (Aktiver Jobbakke)

Cancel (lAnnuIIler)llukker Ul og vender menuen er som standard afmaerket

tilbage til plug in siden. (Til) pa skrivebordet. Enable Context

Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pa jobbakke-ikonen

viser menufunktionerne for Help (Hjelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).

13



3. Billedoptimering

* Run at Startup (Ker ved opstart) er
som standard afmeerket (Til). Nar den
er deaktiveret, starter SmartControl Lite
ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indleses
nar denne boks ikke er afmaerket (er
deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)
- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understattet skeerm med DDC/CI er kun Help
(Hjzelp) og Options (Funktioner) til radighed.
Alle andre faneblade i SmartControl Lite er ikke
til radighed.

[ e 2 Pl 22301 {cx20713000003] (X

SmartControl Lite PHILIPS

Input

IEPORTANT! ¥

Ansog In gt in

e Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

* P4 enkeltindgangsskeerme ses dette vindue
ikke.

14

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understattet skeerm med DDC/CI
er kun Help (Hjalp) og Options (Funktioner) til
radighed.

[ o 2 -k 2228 (C32T 880001) 2t

SmartControl Lite PHILIPS

-

LR N

Help > User Manual (Hjzlp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjzelp) rullemenuen. Pa en ikke-understgttet
skeerm med DDC/Cl er kun Help (Hjelp) og
Options (Funktioner) til radighed.

[ e 2 o 7304 (320713000001 )

PHILIPS

SmartControl Lite

U Manal

Tack. fupport



3. Billedoptimering
Help > Version (Hjelp > Version) - er kun aktiv,
narVersion (Version) er valgt i Help (Hjelp)
rullemenuen. P& en ikke-understgttet skeerm
med DDC/Cl er kun Help (Hjeelp) og Options
(Funktioner) til radighed.
[ e 3 e 2230 (arssemmsen) (T
SmartControl Lite PHILIPS

Version

Adpst

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmeerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

E SmartControl
Helect Preset L3
Tune Display

”Context” (Indhold) menuen har tre punkter:

* SmartControl Lite - nar valgt, ses About
(Om) skaermen.

*  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skeerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

*  Help (Hjeelp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

»  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite.

Huvis du vil kere SmartControl Lite igen,

skal du enten valge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS

SeariControl
‘“erzion 320
diune-standard-£2007-01-04-1151.23
Cppright 19E3.2007 Parrat Digplays, ine.
Patarty




3. Billedoptimering

Task Tray (Jobbakke) menu deaktiveret

Nar Task Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).
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4. Tekniske specifikationer

Skeermpaneltype TFT-LCD

Baggrundslys LED

Panelstarrelse 21.5" W (54,6cm)
Billedforhold 169

Pixel pitch 0,248 x 0,248 mm
Lysstyrke 250 cd/m? or 200 cd/m?
Smart-kontrast 10,000,000:1
Kontrastforhold (norm.) 1000:1 or 600:1 for 200 nits
Reaktionstid (norm.) 5 ms

Optimal oplagsning

1920 x 1080 pa 60 Hz

170° (H) / 160° (V) ved C/R > 10

Simplificeret Kinesisk, Portugisisk og Tyrkisk

Synsvinkel or 90° (H) / 65° (V) ved C/R > 10 for 200 nits

Skeermfarver 16,/ M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

Inputsignal DVI (digital), VGA (Analog)

Inputsignal Separat synk,, synk. pa gren

Brugerfunktioner 226VALA: auTo/v /A /4 B/K 0}
. 26VAL. ao/v  EI/A /4 B/oK 0

OFD) ame Engelsk, Fransk, Tysk, Spansk, Italiensk, Russisk,

Andre funktioner

Kensington-las

"Plug & Play" kompatibilitet

Vip

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

226V4LA:

Teendt-tilstand

21,45W (typ.), 25,65W (maks.)

| dvale (Standby) 0,5W
Fra 05W
Stremdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

226VA4L:

Teendt-tilstand

21,5W (typ.), 23W (maks.)
or 20,5W (typ.), 23,71W (maks.) for 200 nits

17




| dvale (Standby)

0,5W

Fra

0,5W

Stremdiode

Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

Produkt uden fod (B x H x D)

514 x 388 x 213 mm

Produkt uden fod (B x H x D)

514 x 320 x 48 mm

Produkt med fod 3,34kg
Produkt uden fod 3,00kg
Produkt med emballage 4,5%g

Myndighedernes godkendelser

Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°Ctil 60°C
Relativ fugtighed 20% til 80%
MTBF 30.000 timer
[ Mijomassige forhotd
ROHS JA
EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig
Specifikt hovedindhold 100% PVC BFR-fri kabinet
Energy Star JA

CE Meerket, FCC Klasse B, GOST, SEMKO, TCO Godkendt (Only
for selective models), UL/cUL, 1S09241-307,BSMI

Farve Sort
Overflade Blank/Tekstur
@ Bemaerk

RN

for registreringsstatus i dit land.

N

version af brochuren.

EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net

Disse data kan endres uden varsel. Ga til www.philips.com/support for at hente den seneste




4.1 Oplesning og forudindstillede
funktioner

El Maksimal oplesning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)

E Anbefalet oplasning
1920 x 1080 ved 60 Hz (digital indgang)

3147 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86

63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

& Bemark

Bemaerk venligst at din skaerm virker bedst med
native oplgsning pa 1920 x 1080 ved 60Hz. For
at opna den bedste skeermkvalitet, bedes du
venligst bruge denne oplasning.
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5] Stremstyring

5. Stremstyring

Hvis der er installeret et skeermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skaermen automatisk
nedseette stremforbruget, nar den ikke bruges.
Nar input fra tastatur; mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

226V4LA:
VESA .
tilstand Video |V synk | Lsynk | Opbrugt strem | LED Farve
Aktiv TIL Ja Ja 21,45W (norm.) Hvid
| dvale . . Hvid
Gy || T || NS || N O (@7e) (blinker)
Kontakt Fra| FRA - - 0.5W (typ.) FRA
226VA4L:
VESA )
tilstand Video | V synk | L synk | Opbrugt strem | LED Farve
21,5W (norm.)
Aktiv TIL Ja Ja  [or20,5W (norm.) Hvid
for 200 nits
| dvale . . Hvid
Gy | T || N || N OSWMHP) | (plinken)
Kontakt Fra| FRA - - 0,5W (typ.) FRA

Folgende opsatning bruges til at méle
skeermens stremforbrug.

* Indbygget oplasning: 1920 x 1080
»  Kontrast: 50%
*  Lysstyrke: 250 nits or 200 nits

» Farvetemperatur: 6500k med fuldt, hvidt
mgnster

@ Bemaerk
Disse data kan andres uden varsel.
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery

¢ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

21

» Electric and magnetic fields emissions as
low as normal household background
levels.

*  Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and T-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT
(www.epeat.net)
3 The EPEAT (Electronic
Q® Product Environmental
<

Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

e EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

e 2006/95/EC (Low Voltage Directive).

e 2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing  Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product

rerfi meets the ENERGY STAR?

guidelines for energy efficiency.

& Note
We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
l'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Lovmassige oplysninger

Cependant, rien ne peut garantir I'absence EN 55022 Compliance (Czech Republic Only)

d'interférences dans le cadre d'une . —
Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-

I I | e | I I d that it is & Class A devi th ificati . The t e
installation particuliére. Si cet appareil est 0o It A 4 A S et w1 4 e, U 1 1
" 2 el davi b 1o take all staf to f intarfarence to tels-
la cause d'interférences nuisibles pour oS I 0= 10 1ok 2 b necasary fo 1emous soures of inrfarence fo ls
la réceptlon des Signaux de radio ou de Pokud nenf na typowam Etithu poiitate uvedeno, 28 spada do do tfidy A podie EN 55022,
P . ~ , , spadd automaticky do ffidy B podle EN 55022, Pro zafizenl zafazend do tidy A (chranné
télévision, ce qui peut étre décelé en péama 30im) poclie EN 85022 plati néslecluel Dojde-i k rullen teickormunikatnich nobo

R . Jjch zafizani je utivatel povinnen provést takovd opatignl, aby nseni odstranil,
fermant I'équipement, puis en le remettant

en fonction, |'utilisateur pourrait essayer de

corriger la situation en prenant les mesures Polish Center for Testing and Certification
suivantes: Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

* Réorienter ou déplacer I'antenne de
réception.

*  Augmenter la distance entre 'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit

que celui utilisé par le récepteur. The phasing conductor of the room's electrical

installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou

péripheriques. and PN-89/E-06251.

CET APPAREIL NUMERIQUE DE LA CLASSE

B RESPECTE TOUTES LES EXIGENCES DU Wymagania Polskiego Centrum Badan i Certyfikacji
REGLEMENT SUR LE MATERIEL BROUILLEUR A R Rl T R e
DU CANADA. e T ey

W celu catkewitego wylscamia uregdeenss ¢ stect zasilania, nalezy wyjat wivezke kabla
sasilajacepa # ginedka, kdre powinno srejdowa ssg w poblizn urzilzenia § by batwo dostepie.

Laak beaplecesfarwn "B” potwiendes zpodaedl urepdeena » wymagaidainl beeplecaiisroa
ueytkowania zawartymi w PN-S3T-42107 § PN-BAE46251

Pozostale instrukcje begpieczensiwa

* Nie mlezy urywad wiycsek sdapterowyeh lub usuwaé kolka abwodu ochronnega 2 wiyesk.
Jekeli kemsecne jest byese proedluzscza t naledy wkyé preediuiace 3-bylowega 2
i demn ol

* Sysiem ( ey ieceyd proed nagiymi, ymi warostami fub spad-
e i, wEyapp ehicimstins preoyiet, et op AT HERE b
berzakldceniomega irodia asilania.

* Naley upewni sig. sby nic nic leralo na ksblach sysienu kompuierowego, araz aby kable nic
byky umiesaczone w mlejscu, pdzie mokna byboby na nie nadeptywad lub pocykd sig o tie.

* i maledy rolewad napaom s nayel plydn s syssen Koeputesony.

Nie maleqy whychat adnych g fw systemm iy moie

1o spowndowa pogar \uhpm:lmme;r.(dcm poprzes avearcie chemenidn: wewngtranych

* Systems kopaternwy pasinien snajdowad sig 2 dala od graejnikiu i Sidel clepl Porsdto,
nie naleiy blokswad atwordw wentylacyjuych. Nabeiy unikat kladeensa lainych papserdn posd
kemputer oeas umiesrcrania kamputera w cinsym miejses ber mailiwaici cyriulaci powi-
etz wokil nisge.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@RGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZHARERRE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfilit sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Lovmassige oplysninger
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

&Note
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skaeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at vaere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skarm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
geelder i hele verden.

sub-pixler sub-pixler  sub-pixler

VT

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primerfarverne red, gren og
bla. Nar mange pixler settes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstdr som
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skeermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I C

To sammenliggende teendte sub-pixler:
- Red + Bla = Lilla
- Red + Gren = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende teendte pixler (en hvid
pixel).
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% Bemaerk

En red eller bla lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte megrke prikker

Defekte morke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er “slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
ndr skaermen viser et merkt megnster. Der er
folgende typer defekte merke prikker.

Tatsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for tetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skerm i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BR DOT-D R ! PTAR A
1 teendt sub-pixel 3
2 sammenliggende teendte sub-pixler 1
3 Tre sammenliggende teendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3
BLA DOT-D R PTAB
1 mark sub-pixel 5 eller ferre
2 sammenliggende marke sub-pixler 2 eller feerre
3 sammenliggende mgrke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre
& Bemark
1. 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
2. Denne monitor er i overensstemmelse med 1509241-307 (1SO9241-307: Testmetoder for
ergonimiske krav, analyse og overensstemmelse pa elektroniske visuelle skeerme)
3. 1SO9241-307 is de opvolger van de voormalige ISO13406-standaard, die op 13 november 2008

ingetrokken is door de International Organisation
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7.2 Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stattekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tlf Pris

Germany Siemens 1&S +49 01803 386 853 €009

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
[taly A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 € 0,07

Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tif
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
ﬁ’leor?ir%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ui NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
E— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

- Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tif: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tif
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Kontaktoplysninger til APMEA:

A

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd- |\, -\ Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS o 56477
Indonesia NA PT. Gadingsari elektronika Prima [EoiE i et
7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
United Arab 5 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Inf i +84 8 38248007 Ho Chi Minh City
Vietnam NA Com e;nv'cft d” Ormatic +84 5113.562666 Danang City
e +84 5113562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
anglades Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der; efter at du har prgvet disse lasninger, skal
du kontakte Philips' kundeservice.

(1] Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at ledningen er sat i
stikkontakten og bag pa skarmen.

¢ Kontroller farst, at stramkontakten foran
pa skaermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
*  Kontroller, at der er teendt for computeren.

*  Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pa signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

*  Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek om skermkablets stikben er bgjede.

* Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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& Bemark
Den automatiske funktion er ikke n@dvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
* Forsag ikke selv at fejlfinde

e Treek straks skeermens stik ud af
stikkontakten

» Kontakt straks en repreesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skarmen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

T

e Justér billedet med funktionen "Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

=

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

*  Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.



Billedet er sloret, uklart eller for mgrkt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pd skaermen.
“Breendmaerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt fenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

*  Serg altid for at aktivere en pauseskaerm,
der bevager sig, nar skeermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskeerm eller
et andet program, der opdaterer skaermen
regelmeessigt, hvis LCD skaermen viser
statisk materiale i leengere perioder.

*  Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
deekket af garantien.

Billedet er forvrenget. Tekst er utydelig eller

sloret.

* Indstil pc'ens skeermopl@sning som
skaermens anbefalede, native opl@sning.

Der ses rgde, bld, mgrke og hvide pletter pa

skermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Teendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Teendt” lyset med
Strgmdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2 Generelle FAQ

SP1: Hvad skal jeg gore, hvis skaermen under

installationen viser “Cannot display

this video mode” (Kan ikke vise denne

videotilstand)?

Sv.. Den anbefalede oplasning pa denne

skaerm: 1920 x 1080 pa 60 Hz.

*  Frakobl alle kabler og forbind derefter

pc'en til skeermen, som du brugte for

* | Windows Startmenuen, veelg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet veelg
Display (Skeaerm)-ikonet. | Egenskaber for
Skaerm-vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjeelken pa 1920 x
1080 pixler.

+  Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 og bekreeft, at pc'en er indstillet til
1920 x 1080 ved 60 Hz.

*  Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skeaermen.

e Tend for skeermen og derefter for pc'en.

SP2: Hvad er den anbefalede
opdateringshastighed pa LCD skermen?
Sv.. Den anbefalede opdateringshastighed
pa LCD skerme er 60 Hz. | tilfeelde af
forstyrrelser pa skaermen skal du sette
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Sv..  Dette er skermens driverfiler: Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om
en driverdisk, nar du installerer skaeermen

forste gang. Indsaet (medfelgende cd-rom)



SP4:

Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8:

Sv.:

i pakken i henhold til vejledningerne.
Skeaermdrivere (.inf og .icm filer) installeres
automatisk.

Hvordan justerer jeg oplesningen?
Skeermkortet/grafikdriveren og skermen
bestemmer sammen opl@sningerne til
radighed. Du kan veelge den gnskede
oplgsning under “Egenskaber for Skeerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skarmen?

Sa skal du blot trykke pa OK og derefter
vaelge “Reset”” (Nulstil) for at ga tilbage til
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsaette
skaermens overflade for kraftige stad.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skarmens
overflade?

Til normal renggring skal du blot anvende
en ren, bled klud.Til kraftigere rengaring
skal du bruge isopropylalkohol. Brug

ikke andre oplgsningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

Kan jeg @ndre skermens farveindstilling?
Ja, du kan andre farveindstillingen via
OSD pa felgende made:

Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow” (Ned-pil) for

at veelge indstillingen “Color” (Farve),

og tryk derefter pa "OK" for at angive
farveindstillingen. Der er tre indstillinger,
som vist nedenfor.

1. Farvetemperatur med to indstillingen,
6500K og 9300K. Med indstillinger i
6500K omradet virker skermen "varm,
med en rgd-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan veelge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

& Bemark

En malning af farven pa lys, der udstrdles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rgde,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere nadvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler,
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger:

SP10: Er Philips LCD skarme “Plug & Play”?

Sv.: Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skaerme?
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skeermen.
“Breendmeerker”, “efterbilleder”, og
“spagelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfeelde vil “brandmarkerne” eller
“efterbilledet” eller “spggelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskaerm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskezerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder.

O Advarsel

Hvis der ikke aktiveres en pauseskeerm eller
et program til periodisk skeermopdatering, kan
det resultere i alvorlige “fastbrendinger” eller
“efterladte billeder” eller "spggelsesbilleder”,
hvis symptomer hverken forsvinder eller kan
repareres. Ovenstaende skade dakkes ikke af
garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv.. Din LCD monitor virker bedst pa dens
native oplgsning pa 1920 x 1080 ved
60 Hz. Brug denne oplasning for at opna
det bedste billede.
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